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1  Safety and regulatory information
The product documentation helps you use the product safely and efficiently. Follow the
instructions provided here and in the following chapters.

Intended use

The product is intended for the development, production and verification of electronic
components and devices in industrial, administrative, and laboratory environments.
Use the product only for its designated purpose. Observe the operating conditions and
performance limits stated in the data sheet.

Where do I find safety information?

Safety information is part of the product documentation. It warns you of potential dan-
gers and gives instructions on how to prevent personal injury or damage caused by
dangerous situations. Safety information is provided as follows:
● In Chapter 1.1, "Safety instructions", on page 5. The same information is provi-

ded in many languages as printed "Safety Instructions". The printed "Safety
Instructions" are delivered with the product.

● Throughout the documentation, safety instructions are provided when you need to
take care during setup or operation.

1.1  Safety instructions

Products from the Rohde & Schwarz group of companies are manufactured according
to the highest technical standards. To use the products safely, follow the instructions
provided here and in the product documentation. Keep the product documentation
nearby and offer it to other users.

Use the product only for its intended use and within its performance limits. Intended
use and limits are described in the product documentation such as the data sheet,
manuals and the printed "Safety Instructions". If you are unsure about the appropriate
use, contact Rohde & Schwarz customer service.

Using the product requires specialists or specially trained personnel. These users also
need sound knowledge of at least one of the languages in which the user interfaces
and the product documentation are available.

Reconfigure or adjust the product only as described in the product documentation or
the data sheet. Any other modifications can affect safety and are not permitted.

Never open the casing of the product. Only service personnel authorized by
Rohde & Schwarz are allowed to repair the product. If any part of the product is dam-
aged or broken, stop using the product. Contact Rohde & Schwarz customer service at
https://www.rohde-schwarz.com/support.

Safety instructions

https://www.rohde-schwarz.com/support
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Lifting, carrying and installing the product

The product is heavy and must be installed and set up by trained staff. Always use
appropriate lifting equipment when you lift or carry the product, like a forklift when the
R&S QAR50 is still packed in its original box or a crane when it is unpacked.

Lifting and carrying heavy items can cause structural or muscular injuries. Heavy items
can also cause other physical injuries like crushed body parts when they fall or tip over.

Because of its weight, at least two strong people are required to move or install the
R&S QAR50. During the installation, make sure that the installation site is only accessi-
ble to people working on the installation.

During transport, installation or repair, wear appropriate protective clothing that com-
plies with your local rules and regulations. If you are unsure of which equipment to use,
ask your safety inspector.

We recommend to wear:
● Safety shoes with toe cap and ESD protection.
● Protective gloves

Always place the product on a stable, flat and level surface with the bottom of the prod-
uct facing down. If the product is designed for different positions, secure the product so
that it cannot fall over.

Choosing the operating site

Only use the product indoors. The product casing is not waterproof. Water that enters
can electrically connect the casing with live parts, which can lead to electric shock,
serious personal injury or death if you touch the casing. If Rohde & Schwarz provides
accessories designed for your product, e.g. a carrying bag, you can use the product
outdoors.

Unless otherwise specified, you can operate the product up to an altitude of 2000 m
above sea level. The product is suitable for pollution degree 2 environments where
nonconductive contamination can occur. For more information on environmental condi-
tions such as ambient temperature and humidity, see the data sheet.

Connecting to power

The product is an overvoltage category II product. Connect the product to a fixed
installation used to supply energy-consuming equipment such as household applian-
ces and similar loads. Keep in mind that electrically powered products have risks, such
as electric shock, fire, personal injury or even death. Replace parts that are relevant to
safety only by original parts, e.g. power cables or fuses.

Take the following measures for your safety:
● Before switching on the product, ensure that the voltage and frequency indicated

on the product match the available power source. If the power adapter does not
adjust automatically, set the correct value and check the rating of the fuse.

● Only use the power cable delivered with the product. It complies with country-spe-
cific safety requirements. Only insert the plug into an outlet with protective conduc-
tor terminal.

Safety instructions
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● Only use intact cables and route them carefully so that they cannot be damaged.
Check the power cables regularly to ensure that they are undamaged. Also ensure
that nobody can trip over loose cables.

● If you connect the product to an external power supply, use the one delivered with
the product or recommended in the product documentation. The external power
supply must conform to the country-specific regulations.

● Only connect the product to a power source with a fuse protection of maximum
20 A.

● Ensure that you can disconnect the product from the power source at any time.
Pull the power plug to disconnect the product. The power plug must be easily
accessible. If the product is integrated into a system that does not meet these
requirements, provide an easily accessible circuit breaker at the system level.

Cleaning the product

Use a dry, lint-free cloth to clean the product. When cleaning, keep in mind that the
casing is not waterproof. Do not use liquid cleaning agents.

Meaning of safety labels

Safety labels on the product warn against potential hazards.

Potential hazard

Read the product documentation to avoid personal injury or product damage.

Heavy product

Be careful when lifting, moving or carrying the product. Carrying the product requires a suffi-
cient number of persons or transport equipment.

Electrical hazard

Indicates live parts. Risk of electric shock, fire, personal injury or even death.

Hot surface

Do not touch. Risk of skin burns. Risk of fire.

Protective conductor terminal

Connect this terminal to a grounded external conductor or to protective ground. This connec-
tion protects you against electric shock if an electric problem occurs.

1.2  Labels on the product

Labels on the casing inform about:
● Personal safety, see "Meaning of safety labels" on page 7
● Product and environment safety, see Table 1-1
● Device information is provided on a sticker attached to the connector board.

For details, see Chapter 5.2.6, "Device ID", on page 31.

Labels on the product
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Table 1-1: Labels regarding product and environment safety

Labeling in line with EN 50419 for disposal of electrical and electronic equipment after the prod-
uct has come to the end of its service life.

For more information, see "Disposing of electrical and electronic equipment" on page 82.

1.3  Warning messages in the documentation

A warning message points out a risk or danger that you need to be aware of. The sig-
nal word indicates the severity of the safety hazard and how likely it will occur if you do
not follow the safety precautions.

WARNING

Potentially hazardous situation. Could result in death or serious injury if not avoided.

CAUTION

Potentially hazardous situation. Could result in minor or moderate injury if not avoided.

NOTICE

Potential risks of damage. Could result in damage to the supported product or to other
property.

1.4  Regulatory information

The R&S QAR50 complies with the following regulations.

1.4.1  Regulations for the USA

FCC compliance

This equipment has been tested and found to comply with the limits for Industrial, Sci-
entific and Medical Equipment (ISM), pursuant to part 18 of the FCC Rules. These lim-
its are designed to provide reasonable protection against harmful interference in an
industrial installation. This equipment generates, uses, and can radiate radio frequency
energy, and if not installed and used in accordance with the instructions, may cause
harmful interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does cause
harmful interference other devices, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of
the following measures:

● Reorient or relocate the receiving antenna.
● Increase the separation between the equipment and receiver.
● Consult Rohde & Schwarz customer service for help.

Regulatory information
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1.4.2  Regulations for Canada

ICES-001 compliance

This class A ISM device complies with Canadian ICES-001.

Cet appareil ISM de la classe A est conforme à la norme NMB-001 du Canada.

1.5  Korea certification class A

이 기기는 업무용(A급) 전자파 적합기기로서 판매자 또는 사용자는 이 점을 주의하시기
바라며, 가정외의 지역에서 사용하는 것을 목적으로 합니다.

Korea certification class A
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2  Documentation overview
The user documentation for the R&S QAR50 consists of several documents.

Getting started

Introduces the R&S QAR50 and describes how to set up and start working with the
product. A printed version is included in the delivery.

User manual

Contains a description of the R&S QAR50 system, including the features available in
the R&S QAR50 application.

A digital version of the user manual in html format is available in the measurement
application.

Safety instructions

Contains safety instructions, operating conditions and further important information.
The printed safety instructions are part of the delivery.

Data sheet and brochure

The data sheet contains the technical specifications of the R&S QAR50, its options and
accessories.

The brochure provides an overview of the R&S QAR50 and its characteristics.

Open-source acknowledgment (OSA)

The open-source acknowledgment documents provide verbatim license texts of the
used open source software.

The OSAs is available in the measurement application ("Info" > "Open Source
Acknowledgement") and on the SSD in the folder C:\OpenSourceAgreement.



WelcomeR&S®QAR50

11User Manual 1179.4992.02 ─ 05

3  Welcome
The R&S QAR50 is the ideal tool for accurately testing the quality of radomes and
bumpers in the automotive radar frequency range at the end-of-line (EOL). It features
sufficient space to easily accommodate bulky bumpers combined with spatially
resolved measurements to evaluate the homogeneity of design emblems. Its innova-
tive hardware concept enables impressively fast measurement times whereas the
modular software concept allows adaptation to your particular requirements.

Measurements:
● Precise reflection measurements from both sides for two frequency bands.
● Frequency-resolved reflection and transmission loss measurement.
● Transmission phase measurement.
● High-resolution reflection image.
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4  Preparing for use
Here, you can find basic information about setting up the product for the first time.

4.1  Choosing the operating site

Specific operating conditions ensure proper operation and avoid damage to the prod-
uct and connected devices. For information on environmental conditions such as ambi-
ent temperature and humidity, see the data sheet.

For safety information, see "Choosing the operating site" on page 6.

► NOTICE! Overheating can damage the product.
Prevent overheating as follows:

● Keep a minimum distance of 10 cm between the fan openings of the product
and any object in the vicinity to provide sufficient airflow and ventilation. Sev-
eral fan openings are located on either side of the R&S QAR50.

● Do not place the product next to heat-generating equipment such as radiators
or other products.

Electromagnetic compatibility classes

The electromagnetic compatibility (EMC) class indicates where you can operate the
product. The EMC class of the product is given in the data sheet.
● Class B equipment is suitable for use in:

– Residential environments
– Environments that are directly connected to a low-voltage supply network that

supplies residential buildings
● Class A equipment is intended for use in industrial environments. It can cause

radio disturbances in residential environments due to possible conducted and radi-
ated disturbances. It is therefore not suitable for class B environments.
If class A equipment causes radio disturbances, take appropriate measures to
eliminate them.

4.2  Unpacking and checking

The R&S QAR50 is a large and heavy device. Unpacking, moving and installing the
R&S QAR50 requires special arrangements. Follow the instructions provided here
when you unpack the R&S QAR50.

Also see "Lifting, carrying and installing the product" on page 6.

If you do not have appropriate lifting equipment, contact your Rohde & Schwarz repre-
sentative.

Unpacking and checking
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Unpacking the R&S QAR50

1. WARNING! Risk of physical injury caused by heavy items. See "Lifting, carrying
and installing the product" on page 6.
Move the delivery box to a place near the installation site.

2. Remove the top lid of the wooden box the R&S QAR50 is delivered in.
Disassembling the box requires a screwdriver, because the box parts are screwed
to one another.

3. Remove the bars that hold secure the R&S QAR50 inside the box.

4. Remove the four side parts of the box.

5. Using the delivery notes, check the equipment for completeness.

6. Check the equipment for damage.

If the delivery is incomplete or equipment is damaged, contact Rohde & Schwarz.

7. WARNING! Risk of physical injury caused by heavy items. See "Lifting, carrying
and installing the product" on page 6.
Carefully lift the R&S QAR50 out of the box.

Lifting the R&S QAR50 out of the transport box

Use a crane or similar lifting device to lift the R&S QAR50 out of its transport box.

1. Unpack the R&S QAR50 as described in Chapter 4.2, "Unpacking and checking",
on page 12.

Included in the delivery are four eye bolts. The eye bolts serve as lifting points. Use
these bolts to attach appropriate lifting equipment. We recommend using a crane to
lift and move the R&S QAR50.

2. Screw the four eye bolts into the mounting holes on top of the R&S QAR50.
Make sure that the bolts sit tight in the mounting holes. They sit tight if you cannot
screw them any further into the mounting holes.

3. WARNING! Risk of physical injury caused by heavy items. See "Lifting, carrying
and installing the product" on page 6.
The product is heavy. Moving the R&S QAR50 safely is only possible with appropri-
ate lifting equipment (like a crane) and a suitable lifting harness (like a four leg
rope). Commission personnel that is qualified to safely attach the R&S QAR50 to
the lifting equipment, to operate the lifting equipment and take the necessary safety
measures.
Attach the the lifting device.

Unpacking and checking
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Figure 4-1: Attachment of lifting equipment, for example a rope harness

● Use lifting equipment and harness that can carry the weight of the R&S QAR50
(see datasheet).

● Connect the eye bolts securely to the harness, for example with shackles.
● Distribute the weight equally over all four eye bolts.
● Mount the harness legs at a maximum angle of 45° per eye bolt.

< 45°

Figure 4-2: Eye bolt load limit

4. Move the R&S QAR50 carefully to its operating site and put it firmly onto the
ground.

5. Remove the lifting equipment.

6. Remove the eye bolts from the mounting holes.

7. Proceed with the installation as described in Chapter 4.3, "Installing the
R&S QAR50", on page 15.

8. Retain the original packing material. Use it when transporting or shipping the
R&S QAR50 later.
See also Chapter 17, "Transporting", on page 84.

Unpacking and checking
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4.3  Installing the R&S QAR50

The R&S QAR50 is a large and heavy device. Unpacking, moving and installing the
R&S QAR50 requires special arrangements. Follow the instructions provided here
when you install the R&S QAR50.

See also:
● "Intended use" on page 5
● "Lifting, carrying and installing the product" on page 6

Parts of delivery required for installation

● 1 x R&S QAR5050
● 2 x supporting feet, incl. screws (M8X45) and washers
● 16 x mounting hole caps (M8X16 screws)
● 1 x power cable
● 2 x Allen wrench (1x size 5 and 1 x size 6)

Other required tools for installation

● Open-ended wrench size 19
● Spirit level

Setting up the R&S QAR50

You can set up the R&S QAR50 in two different ways: lying on its long side ("lying posi-
tion") or standing upright on one of its short sides ("upright position"). By default, the
R&S QAR50 is designed to stand on a pair of feet that are part of the delivery.

For the upright position, make sure that the side with the connector board is at the bot-
tom.

The R&S QAR50 must be placed on a level surface. This is important not only for
safety reasons, but also to get valid measurement results. If the body of the
R&S QAR50 is not at a right angle to the floor, measurement results can be invalid.

Installing the R&S QAR50
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1
2

Figure 4-3: Possible operation positions for the R&S QAR50

1 = Lying position
2 = Standing position

Instead of using the supporting feet, you can also integrate the R&S QAR50 in a pro-
duction line system. For these special setups, contact your Rohde & Schwarz repre-
sentative.

Attaching the supporting feet

The R&S QAR50 is delivered with a pair of feet that you can attach to the R&S QAR50.
All required parts (feet, screws and washers) are part of the delivery.

The supporting feet are bent at their ends to make the R&S QAR50 more stable. Make
sure to align the feet correctly with the bent parts facing away from the ends of the
main body.

Figure 4-4: Correct alignment of the supporting feet

After you have unpacked the R&S QAR50, it usually rests in lying position on the floor.
The way to attach the feet depends on the way you set up the R&S QAR50 (lying posi-
tion or upright position).

1. WARNING! Risk of physical injury caused by heavy items. See "Lifting, carrying
and installing the product" on page 6.
Attaching the feet requires you to tilt the R&S QAR50 by 90° at least once.

Installing the R&S QAR50
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To tilt the R&S QAR50, you can attach a suitable aid like a handle to the mounting
holes not needed for the feet. While tilting the R&S QAR50, be careful not to dam-
age the R&S QAR50 or the supporting feet. One person must secure the
R&S QAR50 while another person tilts the R&S QAR50.
For the lying position, proceed as follows to attach the supporting feet.

a) Tilt the R&S QAR50 by 90° to an upright position (make sure that the side with
the connector board is on the bottom).

Figure 4-5: Tilting the R&S QAR50 into an upright position

b) Screw the two feet to the mounting holes indicated in Figure 4-6 with an Allen
wrench. The screws and wrench are part of the delivery (M8X45).
Put the washers between screw heads and feet.

Figure 4-6: Attaching the supporting feet for lying position

c) Screw in the caps of the mounting holes (M8X16 screws). The caps are part of
the delivery.

Installing the R&S QAR50
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d) Tilt the R&S QAR50 back to the lying position.

Figure 4-7: Final lying position

2. For the upright position, proceed as follows to attach the supporting feet.
In the upright position, make sure to install the feet on the side of the R&S QAR50
that contains the connector board.

a) Screw the two feet to the mounting holes indicated in Figure 4-8 with an Allen
wrench. The screws and wrench are part of the delivery (M8X45).
Put the washers between screw heads and feet.

Figure 4-8: Attaching the supporting feet for upright position

b) Screw in the caps of the mounting holes (M8X16 screws). The caps are part of
the delivery.

c) Tilt the R&S QAR50 by 90° to an upright position (make sure that the side with
the connector board is on the bottom).

Figure 4-9: Final upright position

Installing the R&S QAR50
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3. For both positions, make sure that the R&S QAR50 is in a stable position.

a) Check with a spirit level if the R&S QAR50 itself is level.
b) If necessary, remove any irregularities by adjusting the height of the feet with

the open-ended wrench until the R&S QAR50 is level.

Figure 4-10: Adjusting feet height

● A clockwise movement lowers the corresponding foot.
● A counterclockwise movement raises the corresponding foot.

c) Tighten the feet with the check nuts using the open-end wrench.

Moving the R&S QAR50

Use a crane or similar device to move the R&S QAR50 from one location to another.

The process is similar to lifting the R&S QAR50 out of the transport box ("Lifting the
R&S QAR50 out of the transport box" on page 13).

During the whole process, the feet can remain attached to the R&S QAR50.

1. WARNING! Risk of physical injury caused by heavy items. See "Lifting, carrying
and installing the product" on page 6.
The product is heavy. Moving the R&S QAR50 safely is only possible with appropri-
ate lifting equipment (like a crane) and a suitable lifting harness (like a four leg
rope). Commission personnel that is qualified to safely attach the R&S QAR50 to
the lifting equipment and to operate the lifting equipment.
Unscrew the caps of the mounting holes you need (M8X16 screws).
Depending on the setup (lying or upright position), use the mounting holes indica-
ted in Figure 4-11 to lift the R&S QAR50. Do not use different mounting holes and
always use four mounting holes to distribute the weight equally.

● For the lying position: Use the mounting holes on top of the R&S QAR50. Use
either the four outer mounting holes (variant 1 in Figure 4-11) or the inner
mounting holes (variant 2 in Figure 4-11).

● For the upright position: Use the mounting holes on the opposite side of the
connector board. The side with the connector board must always be on the bot-
tom.

Installing the R&S QAR50
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Figure 4-11: Attachment points for lifting equipment

1 = Attachment points for lying position (variant 1)
2 = Attachment points for lying position (variant 2)
3 = Attachment points for upright position

2. Screw the eye bolts that were part of the delivery securely into the mounting holes.
They sit tight if you cannot screw them any further into the mounting holes.

3. Attach lifting equipment as described in "Lifting the R&S QAR50 out of the trans-
port box" on page 13.

4. Carefully move the R&S QAR50 to its new location.

5. Remove the lifting equipment from the R&S QAR50.

6. Remove the eye bolts from the mounting holes.

7. Screw the caps of the mounting holes back in (M8X16 screws).

4.4  Considerations for test setup

Integration of the R&S QAR50 at the workplace

The R&S QAR50 has several edges that are required by its functionality. To avoid
physical injuries like head lacerations, take care of an appropriate ergonomic integra-
tion of the device at the workplace, especially if frequent human interaction with the
device is expected.

Cable selection and electromagnetic interference (EMI)

Electromagnetic interference (EMI) can affect the measurement results.

Considerations for test setup
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To suppress electromagnetic radiation during operation:
● Use high-quality shielded cables, for example, double-shielded RF and LAN

cables.
● Always terminate open cable ends.
● Ensure that connected external devices comply with EMC regulations.

4.5  Connecting the R&S QAR50

The following overview shows the possible connections for the R&S QAR50.

R&S QAR50

AC power

Monitor (DisplayPort)

LAN

Keyboard / mouse (USB)

Figure 4-12: Connections for the R&S QAR50

1. Connect a monitor to the DisplayPort port on the R&S QAR50.
As a power source, you can use a household AC outlet to supply the monitor with
power (for monitors with a light-current extension cable).

Note: We recommend using a monitor with a resolution of at least 1920 x 1080.
Lower resolutions can lead to an incorrect display of the measurement data.

2. Connect a keyboard and a mouse to two of the USB ports.

3. Optional: Establish a connection to your LAN via the LAN interface.

Note: Always connect all devices before connecting the R&S QAR50 to the mains
supply.

Network connections

Before connecting the product to a local area network (LAN), consider the following:
● Install the latest software to reduce security risks.
● For internet or remote access, use secured connections if applicable.
● Ensure that the network settings comply with the security policies of your company.

Contact your local system administrator or IT department before connecting your
product to your company LAN.

● When connected to the LAN, the product can potentially be accessed from the
internet, which can be a security risk. For example, attackers might misuse or dam-
age the product.

Connecting to power

The R&S QAR50 contains an AC power supply on the connector board.

Connecting the R&S QAR50
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For safety information, see "Connecting to power" on page 6.

1. Plug the AC power cable into the AC power connector on the connector board.
Only use the AC power cable delivered with the product.

2. Plug the AC power cable into a power outlet with ground contact.

The required ratings are listed next to the AC power connector and in the data
sheet.

4.6  Switching on or off
Table 4-1: Overview of power states

Status LED Position of power switch

Off Off [0]

Standby  orange [I]

Ready  green [I]

Turning on the R&S QAR50

The product is off but connected to power.

1. Set the switch on the power supply to position [I]. See Chapter 5.2.1, "AC power
supply", on page 29.

The LED of the [Power] key is orange. See Chapter 5.2.2, "Power button",
on page 30.

2. Press the [Power] key.

The LED turns green. The R&S QAR50 boots.

Warming up the hardware

Before using the R&S QAR50, let it warm up to its operating temperature. If the hard-
ware does not reach its operating temperature, measurement results can be invalid.
The operating temperature depends on the ambient temperature.

After turning on the R&S QAR50 for the very first time, let it warm up for at least 90
minutes.

Each subsequent start of the software automatically heats the hardware to the temper-
ature it had during the last normalization. This fast warm-up can take up to 20 minutes.
After that time period, you can start measuring with your R&S QAR50.

You can interrupt the fast warm-up. If you do so, normalize the measurement. Other-
wise, measurements results can be invalid.

If the operating temperature of the last normalization has not been reached after 20
minutes, the R&S QAR50 automatically aborts the fast warm-up. In that case, you can-
not start measurements. To be able to measure again, normalize the measurement.

Switching on or off
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Before normalizing measurements, we recommend to let the R&S QAR50 warm up to
its operating temperature. If in doubt, let the R&S QAR50 warm up for 90 minutes (or
until the temperature display is stable).

Shutting down the product

The product is in the ready state.

► Press the [Power] key.

The operating system shuts down. The LED changes to orange.

Disconnecting from power

The product is in the standby state.

1. NOTICE! Risk of data loss. If you disconnect the product from power when it is in
the ready state, you can lose settings and data. Shut it down first.
Set the switch on the power supply to position [0].

The LED of the Power key is switched off.

2. Disconnect the product from the power source.

4.7  Operating system

The R&S QAR50 contains a Microsoft Windows 10 operating system which has been
configured according to the R&S QAR50's features and needs.

The drivers and software installed on the R&S QAR50 are adapted to the R&S QAR50.
Only install software updates released by Rohde & Schwarz.

Service packs and updates

Microsoft regularly creates security updates and other patches to protect Windows-
based operating systems. They are released through the Microsoft Update website and
associated update server. Update instruments using Windows regularly, especially
instruments that connect to a network.

Firewall settings

A firewall protects an instrument by preventing unauthorized users from gaining access
to it through a network. Rohde & Schwarz highly recommends using the firewall on
your instrument. Rohde & Schwarz instruments are shipped with the Windows firewall
enabled. All ports and connections for remote control are enabled.

Note that changing firewall settings requires administrator rights.

Virus protection

Take appropriate steps to protect your instruments from infection. Use strong firewall
settings and scan any removable storage device used with a Rohde & Schwarz instru-
ment regularly. It is also recommended that you install anti-virus software on the instru-

Operating system
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ment. Rohde & Schwarz does NOT recommend running anti-virus software in the
background ("on-access" mode) on Windows-based instruments, due to potentially
degrading instrument performance. However, Rohde & Schwarz does recommend run-
ning it during non-critical hours.

For details and recommendations, see the following Rohde & Schwarz white paper:
● 1EF96: Malware Protection Windows 10

User accounts

The Windows 10 operating system installed on the R&S QAR50 has two predefined
user accounts:
● Standard user account with standard windows rights.

The user name for this account is Operator.
The password is operator<serialnumber>, with <serialnumber> being a
placeholder of the serial number of the R&S QAR50.
Example: operator123456

● Administrator account with rights to install software or create user accounts.
The user name for this account is Admin
The password is emodar8Administrator<serialnumber>, with
<serialnumber> being a placeholder of the serial number of the R&S QAR50.
Example: emodar8Administrator123456

Changing the passwords
For security reasons, we recommend that you to change the passwords after the first
login.

Operating system

http://www.rohde-schwarz.com/appnote/1EF96
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5  Instrument tour
The R&S QAR50 is a millimeter wave imaging system operating in the frequency band
of automotive radar sensors. With its support of spatially resolved reflection and trans-
mission loss measurements, the R&S QAR50 provides an intuitive and powerful way to
evaluate how radomes and bumpers influence the radar performance.

The R&S QAR50 contains the measuring electronics like transmitting and receiving
antennas and a PC with dedicated software to operate and control the measurements.

The meanings of the labels on the product are described in "Meaning of safety labels"
on page 7.

Additional equipment required to run measurements

● (Touchscreen) monitor
● Keyboard
● Mouse

Instrument variants

The R&S QAR50 is available in two variants.
● Variant 02: The antennas on the antenna clusters have a vertical polarization.
● Variant 03: The antennas on the antenna clusters have a horizontal polarization.

5.1  System overview

The visible part of the R&S QAR50 system consists of several elements that you can
either interact with or that are required for measurement applications.

System overview
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Figure 5-1: System overview

1 = Mounting holes
2 = Supporting feet
3 = Connector board
4 = Verification kit mounting rail
5 = Calibration sphere
6 = Antenna cluster 1
7 = Antenna cluster 2
8 = Absorbers

5.1.1  Connector board

Number of connector boards: 1

Function: The connector board provides various interfaces for external applications.

For more information about available connectors, see Chapter 5.2, "Connectors and
labels", on page 28.

System overview
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5.1.2  Antenna cluster

Number of clusters: 2

Function: The antenna clusters are located in the side body of the R&S QAR50. The
antenna clusters contain the transmit and receive antennas. These antennas transmit
and receive the signals to and from the DUT and digitize the resulting incident wave
quantities, which are in turn the source for the microwave imaging.

Depending on the system variant, the antennas have a vertical polarization or a hori-
zontal polarization.
● The variant with a vertical antenna polarization is required for measurements on

radar covers with a vertical polarization.
● The variant with a horizontal antenna polarization is required for measurements on

radar covers with a horizontal polarization.

You can change the cluster polarization later on with one of the optional upgrade kits
for a polarization change.

The R&S QAR50 contains two clusters:
● Cluster "2" is located on the side of the connector board.
● Cluster "1" is located on the other side.

For better orientation, the cluster numbers are printed on the corresponding cluster.

5.1.3  Absorbers

Number of absorber sheets: 5

Function: The absorber sheets on the inside of the R&S QAR50 eliminate electromag-
netic interferences that would otherwise distort the reflection and transmission mea-
surements.

5.1.4  Mounting rail for the verification kit

Number of mounting rails: 2 (one on each side of the main body)

Function: The mounting rails for the verification kit are located in the center of each
side of the R&S QAR50 body. Use these rails to install the verification kit if you have to
verify the system.

For a comprehensive description of the verification procedure, see Chapter 11, "Sys-
tem verification", on page 54.

5.1.5  Calibration sphere

Number of calibration spheres: 2

Function: The calibration spheres are located in the side body of the R&S QAR50.
The calibration spheres are passive features required for instrument calibration. Sys-

System overview
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tem calibration becomes necessary after a module has been replaced or if the verifica-
tion returns a poor image quality.

For more information about system calibration, contact your service representative or
refer to the service manual.

5.1.6  Supporting feet

Number of supporting feet: 2

Function: The supporting feet provide a means to support the R&S QAR50.

Depending on how you install the R&S QAR50, the supporting feet are either located
on the bottom of the main body of the R&S QAR50 or on the side body that contains
cluster "2".

For more information about installing the supporting feet, see "Attaching the supporting
feet" on page 16.

5.1.7  Mounting holes

Number of mounting holes: 20

Location of mounting holes:
● 8 x mounting holes on the top of each of the side bodies.

Function: These mounting holes provide a means to mount lifting equipment to the
R&S QAR50.

● 4 x mounting holes on the outer side of each of the side bodies.
Function: These mounting holes provide a means to mount the supporting feet or
lifting equipment to the R&S QAR50.

● 4 x mounting holes on the bottom of the main body.
Function: These mounting holes a means to mount the supporting feet to the
R&S QAR50.

Caps (M8X16 screws) cover the mounting holes if the mounting holes are unused.

For more information about mounting supporting feet and lifting equipment, see
"Attaching the supporting feet" on page 16 and "Lifting the R&S QAR50 out of the
transport box" on page 13.

5.2  Connectors and labels

The R&S QAR50 has several connectors for various purposes. All connectors are loca-
ted on the side of the R&S QAR50.

Connectors and labels
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Figure 5-2: Connector overview

1 = USB ports
2 = Power button
3 = USB ports (behind protective cover)
4 = Lock for protected USB port
5 = LAN interface
6 = DisplayPort
7 = AC power supply
8 = Sticker with device ID

5.2.1  AC power supply

Connector type: IEC 60320-1 C14

Function: AC input for a connection to the AC mains supply. You can connect the
R&S QAR50 to networks with different voltage levels (see datasheet for the supported
voltage range). The power supply automatically adapts itself to the voltage level of the
power source.

The power cord necessary to connect the panel to the power supply is part of the deliv-
ery (with country-specific plug).

For more information about using the AC power supply safely, see "Connecting to
power" on page 6.

For more information about supplying the radio with power, see Chapter 4.5, "Connect-
ing the R&S QAR50", on page 21.

Connectors and labels
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Figure 5-3: AC power supply

5.2.2  Power button

Function: A short press turns the R&S QAR50 on and off when it is connected to an
AC power source

The power button contains an LED that indicates the state of the R&S QAR50. For
more information about the power states, see Chapter 4.6, "Switching on or off",
on page 22.

Figure 5-4: Power button

5.2.3  LAN interface

Connector type: RJ45

Function: LAN interface to connect the R&S QAR50 to a local network and for remote
control via SCPI or OPC.

Figure 5-5: LAN interface

5.2.4  USB ports

Connector type: USB 3.0 type A

Number of ports: 4

Function: USB ports for various uses.

● Connection of a keyboard to operate the R&S QAR50.
● Connection of a mouse to operate the R&S QAR50.
● Connection of a memory stick, for example to update the software or export mea-

surement results.

Note that the fourth USB port is located behind a protective cap that you can open with
a triangular wrench.

Connectors and labels
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Locked USB ports
Some service and maintenance tasks require access to one of the USB ports. If you
lock the USB ports, for example for security reasons, these tasks can no longer be per-
formed.

Figure 5-6: USB port

5.2.5  DisplayPort connector

Connector type: DisplayPort

Function: DisplayPort for connection of a touchscreen or monitor that you can use to
control the R&S QAR50 and view the measurement results.

Figure 5-7: DisplayPort connector

5.2.6  Device ID

The unique device identifier is provided as a barcode sticker on the connector board on
the side of the R&S QAR50.

It consists of the device order number, the serial number and a checksum.

Example 1343.0099K02-123456-aa.

Connectors and labels
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6  Test setup
The test setup for measurements with the R&S QAR50 basically consists of a
R&S QAR50 and a DUT located between the two clusters. The position of the DUT rel-
ative to the clusters is determined by a coordinate system, whose origin is the center of
cluster 1.

● On the x- and y-axis, we recommend that the center of the DUT corresponds to the
origin of the axes (x and y = 0). Otherwise, results can be invalid.

● On the z-axis, the DUT must have the same distance to both clusters. The distance
between the clusters is 1 m.

Figure 6-1: Location of the DUT relative to the clusters

Two factors determine the test setup:
● The polarization of the clusters.
● The position of the R&S QAR50 (lying or upright).

Note that the verification process is the same for all test setups.

Cluster polarization

The R&S QAR50 is available in two variants. One variant that has vertically polarized
clusters (order no. 1343.0099K02) and one variant that has horizontally polarized clus-
ters (order no. 1343.0099K03). The variant you need depends on the DUT that you are
measuring: radomes for radar sensors with vertical or horizontal polarization.

You can change the cluster polarization later on with one of the optional upgrade kits
for a polarization change.

Instrument position

You can set up the R&S QAR50 in two positions: lying and upright (for details, see
Chapter 4.3, "Installing the R&S QAR50", on page 15). The position of the
R&S QAR50 determines the recommended DUT position.
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Of course, you can position the DUT any way you want, regardless of the R&S QAR50
position. However, doing so can result in a millimeter wave image with an unintuitive
orientation.

● For the lying position, we recommend positioning the DUT facing up. Using that
position, the millimeter wave image also shows the DUT facing up.

● For the upright position, we recommend positioning the DUT facing towards the
R&S QAR50. Using that position, the millimeter wave image shows the DUT facing
up.

Make sure to select the correct instrument position from the device properties.

Example

Assume that you want to evaluate a millimeter wave image of this Rohde & Schwarz
logo. The resulting image should show the logo the right way around.

Regardless of the position of the R&S QAR50, the center of the logo should be aligned
with the center of the clusters. The plate with the logo is thin, so the distance from each
cluster is about 0.5 m. Thicker DUTs might require a different distance to the clusters -
whatever the case, make sure that the distance from both clusters is the same.

Figure 6-2: Example: General DUT position relative to the clusters

With this DUT position, the R&S QAR50 creates an image that shows the complete
logo. To get an image that is also displayed the right way around in the result display,
position the DUT as follows.

● For the lying position, position the logo like this:
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Figure 6-3: Example: DUT position for a lying R&S QAR50

● For the upright position, position the logo like this:

Figure 6-4: Example: DUT position for an upright R&S QAR50

Both DUT positions result in a millimeter wave image with the correct orientation.
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Figure 6-5: Example: Millimeter wave image of the logo
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7  User interface
The graphical user interface (GUI) contains several elements.

1 2 3 4

567891011

Figure 7-1: Overview of the user interface

1 = Menu bar
2 = Measurement description
3 = Millimeter wave image
4 = Result diagram
5 = Measurement control
6 = Numerical results
7 = Measurement duration
8 = Cluster temperature
9 = Measurement preview
10 = Location of measurement result data
11 = System messages

Menu bar
Contains various functions to configure the R&S QAR50 and the measurement.
For more information, see Chapter 9, "Configuration", on page 48 and Chapter 8,
"Measurements and result displays", on page 38.

Measurement description
Contains a short description of the measurement scenario. This description is text you
can define as you like and is stored together with the measurement results.

Millimeter wave image
Shows the image of the DUT.
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For more information, see Chapter 8, "Measurements and result displays",
on page 38.

Result diagram
Available with the optional frequency response application.
Shows the measured DUT characteristics in a diagram.
For more information, see Chapter 8, "Measurements and result displays",
on page 38.

Measurement control
Contains functions to control the measurement sequence.
For more information, see Chapter 8, "Measurements and result displays",
on page 38.

Numerical results
Shows the measured DUT characteristics in a numerical result table.
For more information, see Chapter 8, "Measurements and result displays",
on page 38.

Measurement duration
Shows the time that the measurement took to finish.

Cluster temperature
Shows the temperature of the clusters.

Measurement preview
Shows a preview image of the measurements that you have performed for the DUT. If
no preview is available, the preview image is an image of the R&S QAR50.
For more information, see Chapter 8, "Measurements and result displays",
on page 38.

Location of measurement result data
Shows the directory in which the measurement results have been stored.
For more information, see Chapter 9, "Configuration", on page 48.

System messages
Area that contains system messages, if any occur.
If an error occurs, select "Error" to display the details of all errors in the error queue.
You can use this information to fix the error or forward the information to your
Rohde & Schwarz service representative.
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8  Measurements and result displays
The R&S QAR50 provides several measurements and result displays that you can use
to evaluate the quality of a DUT.

Measurements usually consist of two steps, normalization and the actual measure-
ment.

1. Set up the normalization.

2. Perform the normalization.
For details about measurement normalization, see Chapter 8.1, "Normalization",
on page 38.

3. Place the DUT between the clusters.

4. Start the measurement.
For details about measurement, see Chapter 8.2, "Measurement", on page 40.

5. Evaluate the measurement results using the result displays.
For details about the result displays, see Chapter 8.3, "Result displays",
on page 43.

8.1  Normalization

Normalization is a separate measurement that provide a baseline to which other mea-
surements are compared.

Reflection and transmission measurements must be normalized separately by two sep-
arate measurements.

It is not necessary to normalize every measurement. We recommend normalizing the
measurement regularly. Refer to the datasheet for more information about recommen-
ded normalization intervals.
In addition, the software shows a message if normalization becomes necessary
because of temperature changes or other circumstances.

Warm-up time
Before normalizing a measurement, let the R&S QAR50 warm up to its operating tem-
perature.

Normalizing reflection measurements

Normalizing the reflection measurement requires a clean, smooth and flat metallic
plate for a high reflection, for example aluminum. Such a metal plate represents a DUT
with 100 % reflectivity. Make sure to use a plate that has a size of at least 300 mm x
300 mm.

Normalization
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If you own the verification kit, you can use the verification plate labeled "E" to normal-
ize the measurement.

1. Place the plate between the clusters at the location where the DUT would be.
Make sure that the plate is parallel to the clusters. We recommend using the same
fixture for the metal plate as for the DUT.

2. Select "Normalize Reflection" to initiate the normalization.
When the normalization measurement is done, the R&S QAR50 saves the correc-
tion data. The R&S QAR50 corrects all subsequent measurements accordingly.
A valid normalization results in an image with high reflection. The mean reflection
should be approximately 0 dB and should not exceed a certain deviation from that
value - refer to the datasheet for exact values.

3. Optional: Select "Measure" to verify the normalization (use the same plate as for
normalization).
If the results do not meet the expectations, repeat the normalization.
If the second normalization still yields unexpected results, verify the test setup.
For details about verification, see Chapter 11, "System verification", on page 54.

4. Remove the plate used for normalization and continue with measuring actual
DUTs.

Normalizing the transmission and phase measurement

For the transmission and phase measurement, normalization is a free-space measure-
ment and requires no additional devices. However, make sure that the area between
the clusters is free of obstacles. A free-space measurements represents a DUT with
0 % attenuation.

1. Select "Normalize Transmission" to initiate the normalization.
When the normalization measurement is done, the R&S QAR50 saves the correc-
tion data. The R&S QAR50 corrects all subsequent measurements accordingly.
For the transmission measurement, a valid normalization results in a transmission
of approximately 0 dB attenuation. The transmission attenuation should not exceed
a certain deviation from that value - refer to the datasheet for exact values.
For the phase measurement, a valid normalization results in an image that shows
the same phase throughout the evaluation area of the image - refer to the data-
sheet for exact values.

2. Optional: Select "Measure" to verify the normalization.
If the results do not meet the expectations, repeat the normalization.
If the second normalization still yields unexpected results, verify the test setup.
For details about verification, see Chapter 11, "System verification", on page 54.

3. Continue with measuring actual DUTs.

Normalization
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8.2  Measurement

The R&S QAR50 provides several measurements. Each measurement analyzes cer-
tain characteristics of the DUT.

The basic process of a measurement is easy with the R&S QAR50.

1. Configure the measurement as required.

2. Normalize the measurement, if necessary.

3. Place the DUT in the center of the R&S QAR50, between the clusters.
For a detailed description of the test setup, see Chapter 6, "Test setup",
on page 32.

4. Select "Measure" in the user interface.
The R&S QAR50 initiates the measurement.
The basic principle of all measurements is as follows.

a) One of the clusters generates a signal.
b) The cluster transmits the signal in the direction of the DUT.
c) The signal passes through or gets reflected by the DUT.
d) Both clusters measure the level characteristics of the reflected or transmitted

signal.

Note: If "Measure" is not available, you have to normalize the measurement.

5. Analyze the measurement results using the result displays.

● Reflection measurement......................................................................................... 40
● Transmission measurement....................................................................................41
● Phase measurement...............................................................................................42

8.2.1  Reflection measurement

The reflection measurement determines the percentage of energy that is being reflec-
ted by the DUT over a certain frequency range used by automotive radar sensors. The
result (reflectivity) is the ratio of the reflected energy to the energy of the stimulus sig-
nal over a certain radar band.

The R&S QAR50 measures the reflection of both sides of the DUT:
● Cluster 1 sends a stimulus signal and receives the reflected energy from the side

of the DUT that faces cluster 1.
● Cluster 2 sends a stimulus signal and receives the reflected energy from the side

of the DUT that faces cluster 2.

Measurement
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Figure 8-1: Principle of the reflection measurement

1 = Cluster 1
2 = DUT
3 = Cluster 2
straight line = Stimulus signal
dashed line = Reflected energy

The reflected energy does not pass through the DUT and contributes to performance
degradation as a result. Reflected signals reduce the performance of the radar and can
even interfere with the received signals, leading to effects as described in application
note 1MA267. Areas with a high reflection can have various causes, for example mate-
rial defects, undesired interaction between several layers of materials, excessive
amount of certain materials, or foreign objects.

The R&S QAR50 achieves spatially resolved reflection measurements of a DUT by
linking the information collected by the distributed transmit and receive antennas in a
coherent operation. The resulting millimeter wave image, diagram and numerical
results allow for an intuitive evaluation of the DUTs reflection behavior.

For more information about the result display available for the reflection measurement,
see Chapter 8.3, "Result displays", on page 43.

8.2.2  Transmission measurement

The stimulus signal is split in a reflected and a transmitted part. Therefore, it is of inter-
est to measure not only the reflection characteristics of a DUT, but also the transmis-
sion properties. The result (transmission attenuation) is the ratio of the energy mea-
sured at the receiving cluster to the stimulus signal sent by the transmitting cluster.

For the transmission measurement, both clusters send a signal that passes through
the DUT. The passage through the DUT attenuates the signal. The attenuated signal is
measured by the opposite cluster. The resulting transmission attenuation is the aver-
age of those two measurements.

Measurement
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Figure 8-2: Principle of the transmission measurement

1 = Cluster 1
2 = DUT
3 = Cluster 2
straight line = Stimulus signal
dotted line = Attenuated signal
dashed line = Reflected energy

For more information about the result display available for the transmission measure-
ment, see Chapter 8.3, "Result displays", on page 43.

8.2.3  Phase measurement

In addition to reflection and transmission characteristics, the phase characteristics of
the DUT are also of interest. When a stimulus signal hits the DUT, the DUT changes
the phase characteristics of a signal by a certain amount, depending on its thickness
and material.

For the phase characteristics, both clusters send a signal that passes through the DUT.
The opposite cluster measures the phase of the received signal. The resulting phase
results are the average of those two measurements.

To calculate the phase difference, the R&S QAR50 compares the phase of the normali-
zation measurement (empty space) to that of the actual measurement.

Measurement
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Figure 8-3: Principle of the phase measurement

1 = Cluster 1
2 = DUT
3 = Cluster 2
straight line = Stimulus signal
dashed line = Phase changed signal

For more information about the result display available for the phase measurement,
see Chapter 8.3, "Result displays", on page 43.

8.3  Result displays

The R&S QAR50 provides various result displays that you can use to evaluate the
results of the measurements.

Millimeter wave image...................................................................................................43
Result diagram.............................................................................................................. 45
Numerical result table................................................................................................... 46

Millimeter wave image
The millimeter wave image is a graphical representation of the DUT and its character-
istics. The image is available for all measurements (reflection, transmission and phase)
and both evaluated frequency bands.
You can select the measurement whose image you want to evaluate in more detail
from the "Preview" pane below the image.
● "R<x> Band <y>": Shows the results of the reflection measurement of cluster <x>

(x = 1 or 2) in the frequency band <y> (<y> = 1 or 2).
● "Tx Att. Band <y>": Shows the results of the transmission measurement in the fre-

quency band <y> (y = 1 or 2).
● "R<x> HD": Shows the high definition version of the reflection measurement of

cluster <x> (x = 1 or 2) in the frequency band from 76 GHz to 81 GHz.
Available with the optional HD reflection image application.

● "Phase Band <y>": Shows the result of the phase measurement (phase difference
caused by the DUT) in the frequency band <y> (y = 1 or 2).

Result displays
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Available with the optional phase measurement application.
Band 1 is the frequency band from 76 GHz to 77 GHz. Band 2 is the frequency band
from 76 GHz to 81 GHz.
The currently selected image is highlighted blue in the preview pane.

4

5

3

2

1

Figure 8-4: Overview of the millimeter wave image result display

1 = Complete image of the DUT
2 = Evaluation area
3 = Area that contains values for mean result calculation
4 = Color map
5 = Preview pane

The resulting image shows the measured levels as different shades of color. The color
range depends on the color scheme you have selected.
● For reflection measurements, the image shows the reflectivity in dB. Each color

shade corresponds to a certain reflectivity value.
● For transmission measurements, the image shows the transmission attenuation in

dB. Each color shade corresponds to a certain attenuation value.
A color map next to the image shows the levels that correspond to each shade of color.
All images show the perspective as seen from cluster 1.
For all measurements, the x- and y-axis show the dimensions of the image in mm
(200 mm x 200 mm by default). Note you can change the scale of the x- and y-axis
using a mouse. The default value is restored after a new measurement.
A blue rectangle that is superimposed on the image indicates the part of the image that
is evaluated for the numerical results. The size and location of this evaluation window
depends on your configuration.

Result displays
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A black line within the blue rectangle surrounding certain areas indicates the measure-
ment points that deviate no more than 3 dB from the maximum reflection value or the
minimum attenuation value. There can be several such areas in the image, depending
on the characteristics of the DUT. Those are the measurement points that actually con-
tribute to the mean reflection and attenuation values as indicated in the numerical
result table.
Measuring a homogenous (= flat, highly reflective) DUT usually results in a Gaussian
distribution of reflection values (due to the aperture weights of the antenna array). The
evaluated values are therefore concentrated to a single area in the image.

max. reflection

- 3 dB threshold

value range for 
mean reflection

Figure 8-5: Mean reflection on a homogenous DUT

For inhomogeneous DUTs, the distribution can be different, so there maybe several
highlighted areas in the image, but the evaluation remains the same.

max. reflection

- 3 dB threshold

value range for 
mean reflection

Figure 8-6: Mean reflection on an inhomogeneous DUT

Result diagram
Available with the optional frequency response application.

Result displays
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The result diagram shows the frequency response of the DUT in terms of the level
characteristics of the DUT. The results are displayed as a line trace over a certain fre-
quency range. The R&S QAR50 evaluates the frequency range around the typical
radar bands.
The result diagram is available for both reflection measurements and transmission
measurements.

1 2 3 4

Figure 8-7: Overview of the result diagram

1 = Measurement selection
2 = Trace
3 = Trace minimum indicator (red dotted line)
4 = Radar band indicator (blue area)

For both measurements, the x-axis represents the frequency. The y-axis represents
the level characteristics. For both reflection and transmission measurements, the level
characteristics are values in dB. Note you can change the scale of the x- and y-axis
using a mouse. The default value is restored after a new measurement.
You can also use a mouse to determine the measured values for each pixel of the
trace.
The blue areas in the diagram indicate the two radar bands from 76 GHz to 77 GHz
(dark blue) and 76 GHz to 81 GHz (light blue).
The red dotted lines indicate the trace minimum.
The minimum and maximum values indicate the degree of frequency matching ach-
ieved by the DUT. Ideally, the minimum of the frequency response is located at the
operating frequency range of the radar sensor that is to be used in combination with
the DUT. Shifted minima indicate issues with the DUT's electrical thickness.

Numerical result table
The numerical result table shows the measurement results as numerical values. The
table shows the results in dB (reflection and transmission measurement) and as per-
centage. For the percentage value, the maximum reflection or transmission corre-
sponds to 100 %.

Result displays
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The interpretation of the percentage value depends on the measurement.
● Reflection measurement: 100 % reflection = complete energy is reflected by the

DUT
● Transmission measurement: 100 % transmission attenuation = complete energy is

attenuated by the DUT (no energy arrives at the receiving cluster)

Figure 8-8: Overview of the numerical result table

The numerical results are calculated over all measurement points within the evaluation
window that do not deviate more than 3 dB from the maximum reflection or minimum
attenuation value. These measurement points are indicated by a black line in the milli-
meter wave image.
The table contains the following results:
● Mean reflection for cluster 1 and 2, and frequency bands 1 and 2

The mean reflection indicates the radar transparency of the DUT. The lower the
mean reflection, the better the radar transparency of the DUT. A higher mean
reflection results in beam refraction, increased transmission loss and standing
waves between the DUT and the radar sensor. For optimal radar compatibility, the
DUT's mean reflection has to be minimized.

● Mean transmission attenuation for frequency bands 1 and 2.
The mean transmission attenuation is calculated as follows:
 -20·log10(mean transmission coefficient)
with mean transmission coefficient = 1 - attenuation
The mean transmission coefficient is calculated over the respective frequency
range.

Result displays
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9  Configuration
Access: "Options"

The R&S QAR50 provides a set of tools to configure the measurement.

Selecting the device properties

The device properties select the characteristics of the test setup.

For details about the different test setups, see Chapter 6, "Test setup", on page 32.

Always make sure that the "Device Properties" are set correctly. Otherwise, measure-
ment results can be invalid.

1. Select "Options" > "Settings".

2. Select the position of the R&S QAR50 from the "Shape Setup" menu.

● "U" corresponds to the lying position.
● "C" corresponds to the upright position.
For details about installing the R&S QAR50 in the different positions, see Chap-
ter 4.3, "Installing the R&S QAR50", on page 15.

Using high quality measurement mode

The high quality mode averages the raw data of a series of 10 measurements to create
a more accurate image of the DUT. This measurement mode reduces the noise and
therefore increases repeatability while decreasing ripples in the high resolution images.

Note that using high quality mode increases the measurement time a little.

1. Select "Options" > "Settings".

2. Select "HQ Mode".

Defining the size and position of the evaluation window

The evaluation window is the part of the millimeter wave image that the R&S QAR50
uses to calculate the numerical results.

In the millimeter wave image itself, the evaluation window is indicated by a blue rectan-
gle.

1. Select "Options" > "Settings".

2. Define the "Window Size".
The window is a rectangle whose size is defined by the lengths of its sides in x-
and y-direction. The maximum size of the evaluation window is 100 mm x 100 mm.
The center of the evaluation window is always in the center of the millimeter wave
image.
Always define an evaluation window whose size is smaller than the DUT.
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Figure 9-1: Maximum size (shaded area) of the evaluation window

Defining the size and position of the evaluation window for phase measurements

For phase measurements, there is an alternative to create an evaluation window.
Instead of defining a rectangle with a certain size, you can use masks with arbitrary
shapes.

1. Draw a shape that defines the evaluation window.

2. Save the shape as a monochrome bitmap (.bmp file) with a size of exactly 129 x
129 pixels.
Everything in the bitmap with a value > 0 is evaluated during the measurement.

12
9 

pi
xe

l

129 pixel

Hi!
Figure 9-2: Evaluation window for phase measurements: the word "Hi!" is evaluated

3. Select "Options" > "Settings".

4. Select "Phasemask file" to import the bitmap.

5. Select "Use evaluation phasemask file" to activate the evaluation window.
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As long as this feature is active, the R&S QAR50 uses the bitmap to evaluate
phase measurements instead of the rectangle.
Reflection and transmission measurement continue to use the rectangular window.

Selecting the frequency band

Automative radar sensors typically use the frequency bands from either 76 GHz to
77 GHz or from 76 GHz to 81 GHz.

By default the R&S QAR50 measures the DUT characteristics in both bands. If you
want to test only one of those bands, select the desired band.

1. Select "Options" > "Settings".

2. Select "Band 1" to measure the DUT in the frequency band from 76 GHz to
77 GHz.

3. Select "Band 2" to measure the DUT in the frequency band from 76 GHz to
81 GHz.

Selecting the color scheme of the millimeter wave image

You can select one of several color schemes for the millimeter wave image.

1. Select "Options" > "Settings".

2. Select one of the color schemes from the "Colormap" dropdown menu.

● "Grey": Distribution of level values over gray colors.
● "Jet": Distribution of level values over the complete color range.
● "Hot": Distribution of level values between red and yellow colors.
● "Cool": Distribution of level values between blue and purple colors.

Defining the dynamic range for phase measurements

The results for phase measurements are evaluated over a certain value range that you
can adjust.

1. Select "Options" > "Settings".

2. Define the "Relative Phase Range" for phase measurements.
The value you enter is a deviation from the mean phase that has been measured
(mean phase ± dynamic range). Only phase values within that range get different
shades of colors in the millimeter wave image. Phase values outside that range are
treated as the same phase value and have the same color in the image.
For example, if the mean phase = 20°, a phase range = 30° means that only phase
differences between +50° and -10° are resolved by different colors in the millimeter
wave image.
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Defining an evaluation grid

An evaluation grid helps you to find the areas with highly differing transmission and
phase characteristics on your DUT more easily. The principle is to divide the DUT into
several small areas (cells), and evaluate the characteristics of each cell separately
instead of the complete DUT.

Grid evaluation is a feature that is available via SCPI commands only.

• MEASurement:GRID:CONFig
• MEASurement:GRID:ENABle
• MEASurement:GRID:RESult?
1. Define the size of the grid cells in mm.

2. Define the location of the grid in terms of an offset from the origin of the coordinate
system.

3. Define the size of the grid in terms of the number of cells.
Grid cells are numbered 1 to x, beginning at the top left cell.

1 2 3 4 5

6 7 8 9 ...

Make sure that the size of the grid is no larger than the maximum size of the evalu-
ation window.
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10  Data management
Access: "File" menu

Access: "Options" > "Settings"

You can export the measurement data, for example to store it on an external memory
device or copy it to a different computer for further analysis with different software. You
can also restore data that you have taken at some point and review it in the applica-
tion.

1. Select "Options" > "Settings".

2. Define the default directory in which to save the results in the "Save Path" input
field.
For each measurement, the R&S QAR50 creates a subfolder that contains the
measurement data. This subfolder's name has a variable name that contains the
time stamp of the measurement: yyyymmdd-hhmmss.

3. Select "Autosave after every measurement" to use the auto save functionality.
When you are using the autosave feature, the R&S QAR50 automatically stores
the results after each measurement.

Tip: You can always save the measurement results deliberately using the "File" >
"Save" feature.

4. Select the data you want to save from the "Saving Result" dropdown menu.

● "Statistics": Exports the numerical results from the numerical results table.
● "Statistics, results and images": Exports all measurement results (numerical

results, trace data and 2D imaging data) and the images.
● "Statistics, results, images and volume": Exports all measurement results,

images and the raw 3D imaging data.
Exporting the raw 3D takes a few seconds to export because of the amount of
data that is exported (approx. 10 MB per measurement).
All exports include information about the measurement configuration.

5. Restore the measurement data using the "File" > "Open" feature.
Restoring measurement results requires the full measurement result data
(results.mat). The data package "Statistics + Pictures" only contains the
images (.png) and statistics (numerical results etc.) and is therefore not sufficient
to restore results.

A measurement dataset of results, image and volume contains the following files.
● <yyyy-mm-dd-hh-mm-ss>_config.json

Contains general information about the measurement.
● <yyyy-mm-dd-hh-mm-ss>_result_statistics.json

Contains the numerical measurement results (mean reflection etc.).
● <yyyy-mm-dd-hh-mm-ss>_<measurement>.png
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Image of the measurements (millimeter wave image and frequency response
trace).

● <yyyy-mm-dd-hh-mm-ss>_results.mat
Contains the raw 2D imaging data and the trace data for the result diagram.

● <yyyy-mm-dd-hh-mm-ss>_volume.mat
Contains the raw 3D imaging data.
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11  System verification
The R&S QAR50 provides a verification procedure to validate the quality of the mea-
surements. Verification consists of a series of measurements with standardized DUTs
which are located in the center the R&S QAR50.

Verification requires the verification kit (R&S QAR50-Z44, order no. 1343.0082.02). All
verification objects are delivered with a quality approved surface finish. Any surface
features are either intentional or are considered to be uncritical for the intended pur-
pose.

The verification kit includes the following parts;
● Frame for verification plates
● 2 x plastic verification plates with different thickness
● 1 x glass-ceramic verification plate
● 1 x metal verification plate
● 1 x transparent plastic verification plate for phase measurement verification

The verification plates each have a sticker with some numbers on it. These values indi-
cate the limits that must not be violated during the verification. Each sticker contains
four values:
● a77: one-way mean attenuation in the frequency range from 76 GHz to 77 GHz.
● a81: one-way mean attenuation in the frequency range from 76 GHz to 81 GHz.
● r77: mean reflection in the frequency range from 76 GHz to 77 GHz.
● r81: mean reflection in the frequency range from 76 GHz to 81 GHz.

The process of the verification is independent of the position of the R&S QAR50 (lying
or upright). It works the same in both cases, only the orientation of the verification kit is
either vertical (in lying position) or horizontal (in upright position).

If verification fails, validate the verification setup. If verification fails several times in a
row, despite a valid setup, contact Rohde & Schwarz customer support to calibrate the
R&S QAR50 and check the hardware.

Warm-up time
Before verifiying the system, let the R&S QAR50 warm up to its operating temperature.

Installing the frame for the verification objects

The verification objects come with a frame that holds the objects.

The R&S QAR50 has mounting rails on each side of the main body that can hold the
frame.

1. Slide the frame onto the mounting rails of the R&S QAR50.
You can only install the frame one way with the screws on the frame pointing to the
side that contains cluster "1" as indicated in Figure 11-1.
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Figure 11-1: Installing the verification plate frame

2. Secure the frame by tightening the screws on each side of the frame.

Verifying reflection and transmission measurements

The verification process consists of four consecutive measurements with the verifica-
tion objects (square plates).

The verification objects are labeled A to E.

1. NOTICE! Handling the verification objects.
● Wear the gloves that are part of the delivery when you handle the verification

plates.
● Store the verification plates in the bag they were delivered in.
● Keep the verification plates clean and without fingerprints.
● Do not scratch the verification plates.
● Clean the plates with a lint-free duster or a damp rag. Do not use chemicals.
Normalize the reflection measurement.
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a) Put the metal plate labeled "E" into the frame.

Figure 11-2: Mounting verification plates

b) Select "Normalize Reflection" to initiate a measurement.
c) Wait until the results are displayed.
d) Remove the metal plate from the frame.

The mean reflection should be around 0 dB.

2. Normalize the transmission measurement.

a) Select "Normalize Transmission" to initiate a free-space measurement.

The resulting transmission attenuation should be at approximately 0 dB.

3. Verify the reflection and transmission measurement.

a) Put the glass-ceramic plate labeled "A" into the frame.
b) Initiate a measurement.
c) Remove the plastic plate from the frame.
d) Do the same for the other two plastic plates labeled "B" (plastic) and "C" (plas-

tic).

After each measurement, check the mean transmission loss against the limits a77

and a81 specified on the stickers attached to the verification plates. The sticker
shows the attenuation characteristics of the plate and the deviation the result may
have.
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After each measurement, check the mean reflection against the limits r77 and r81

specified on the stickers attached to the verification plates. The sticker shows the
reflection characteristics of the plate and the deviation the result may have.

Verifying phase measurements

The process to verify phase measurements depends on the verification plate you are
using.

1. For verification plates with a serial number < 101350, proceed as follows.

a) Put the transparent plastic plate labeled "D" into the frame.
Make sure that the plate has the correct orientation.

b) Initiate a measurement.
After the measurement, check the phase results in the millimeter wave image.
Phase steps should be clearly visible in the image.

2. For verification plates with a serial number ≥ 101350, proceed as follows.

a) Select "Options" > "Resolution Verification".
The R&S QAR50 starts a wizard that guides you through the verification.

b) Put the transparent plastic plate labeled "D" into the frame.
Make sure that the plate has the correct orientation.

3. Initiate a measurement for each of the two phase evaluation masks mentioned in
the wizard.
These phase evaluation masks are part of the delivery.
After the measurements, the R&S QAR50 calculates the phase difference of the
two measurements. Compare the results to the values specified on the stickers
attached to the verification plate. The sticker shows the phase deviation of the
plate and the deviation the result may have.
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12  Remote control
You can remote control the R&S QAR50 using SCPI commands.

In addition to the remote control basic in this manual, refer to the following document
available on the R&S QAR50 website provides a general introduction to remote control
using SCPI commands.

https://www.rohde-schwarz.com/manual/remote-control-via-scpi-manuals-
gb1_78701-1090624.html

Note that this document can describe features (especially remote control interfaces
and protocols) that the R&S QAR50 does not support.

● Remote control interface and protocol.................................................................... 58
● Remote control commands..................................................................................... 60
● Remote control examples....................................................................................... 68

12.1  Remote control interface and protocol

For the R&S QAR50, the remote control interface is the LAN interface. The LAN inter-
face consists of a connector, a network interface card and protocols.

The network card can be operated with the following interfaces:
● 10 Mbit/s Ethernet IEEE 802.3
● 100 Mbit/s Ethernet IEEE 802.3u
● 1Gbit/s Ethernet IEEE 802.3ab

For remote control via a network, the PC and the instrument must be connected via the
LAN interface to a common network with TCP/IP network protocol. They are connected
using a commercial RJ45 cable (shielded or unshielded twisted pair category 5). The
TCP/IP network protocol and the associated network services are preconfigured on the
instrument. Software for instrument control and the VISA program library must be
installed on the PC (controller).

IP address

Only the IP address or a valid DNS host name is required to set up the connection.
The host address is part of the "VISA resource string" used by the programs to identify
and control the instrument.

The VISA resource string has the form:

TCPIP::host address[::LAN device name][::INSTR]
where:
● TCPIP designates the network protocol used
● host address is the IP address or host name of the device

inst0 selects the VXI-11 protocol

Remote control interface and protocol

https://www.rohde-schwarz.com/manual/remote-control-via-scpi-manuals-gb1_78701-1090624.html
https://www.rohde-schwarz.com/manual/remote-control-via-scpi-manuals-gb1_78701-1090624.html
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● LAN device name defines the protocol and the instance number of a sub-instru-
ment;

● INSTR indicates the instrument resource class (optional)

Example: 
● Instrument has the IP address 192.1.2.3; the valid resource string using VXI-11

protocol is:
TCPIP::192.1.2.3::INSTR

Identifying instruments in a network
If several instruments are connected to the network, each instrument has its own IP
address and associated resource string. The controller identifies these instruments by
the resource string.

VISA library

A VISA installation is a prerequisite for remote control using the LAN interface.

VISA is a standardized software interface library providing input and output functions to
communicate with instruments. High level programming platforms use VISA as an
intermediate abstraction layer.

The I/O channel (LAN or TCP/IP) is selected at initialization time by one of the follow-
ing:

● The channel–specific address string ("VISA resource string")
● An appropriately defined VISA alias (short name).

For more information about VISA, refer to the VISA user documentation.

VXI-11 protocol

The VXI-11 standard is based on the open network computing remote procedure call
(ONC RPC) protocol which in turn relies on TCP/IP at the network/transport layer. The
TCP/IP network protocol and the associated network services are preconfigured.

TCP/IP ensures connection-oriented communication, where the order of the
exchanged messages is adhered to and interrupted links are identified. With this proto-
col, messages cannot be lost.

SCPI compatibility

SCPI commands (standard commands for programmable instruments) are used for
remote control. The SCPI standard is based on standard IEEE 488.2 and aims at the
standardization of instrument-specific commands, error handling and the status regis-
ters. The tutorial "Automatic Measurement Control - A tutorial on SCPI and IEEE
488.2" from John M. Pieper (R&S order number 0002.3536.00) offers detailed informa-
tion on concepts and definitions of SCPI. The instrument supports the SCPI version
1999.

Commands that are not taken from the SCPI standard follow the SCPI syntax rules.

Remote control interface and protocol
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Communication ports

You have to open several ports in the firewall to be able to communicate via SCPI. By
default, these ports are already open on the R&S QAR50. If you want to close these
ports, you can run a script that closes these ports.

● To close the ports, run the
script .\firewall\firewall-disableaccess.bat.
Closing the ports disables remote control functionality.

● To reopen the ports, run the script .\firewall\firewall-setting.bat.

12.2  Remote control commands

&GTL..............................................................................................................................60
&GTR............................................................................................................................. 61
MEASurement:EVALuation:MASK:ENABle......................................................................... 61
MEASurement:EVALuation:MASK:LOAD............................................................................61
MEASurement:EVALuation:WINDow..................................................................................62
MEASurement:GRID:CONFig............................................................................................62
MEASurement:GRID:ENABle............................................................................................63
MEASurement:GRID:RESult?........................................................................................... 63
MEASurement:HQMode:ENABle....................................................................................... 64
MEASurement:LOAD....................................................................................................... 64
MEASurement:NORMalize:REFLection:REQuired?.............................................................64
MEASurement:NORMalize:REFLection:STARt....................................................................64
MEASurement:NORMalize:TRANsmission:REQuired?........................................................ 65
MEASurement:NORMalize:TRANsmission:STARt............................................................... 65
MEASurement:RESult?.................................................................................................... 65
MEASurement:RESult:DIRectory.......................................................................................65
MEASurement:RESult:SAVE:AUTO................................................................................... 66
MEASurement:RESult:SAVE:WHAT...................................................................................66
MEASurement:SAVE?...................................................................................................... 66
MEASurement:STARt.......................................................................................................67
SYSTem:ERRor............................................................................................................... 67
SYSTem:STATus:ERRor[:NEXT]?......................................................................................67
SYSTem:EXIT..................................................................................................................67
SYSTem:REBoot..............................................................................................................68
SYSTem:STATus:CODE?..................................................................................................68

&GTL

Closes a remote session and returns to local mode.

Remote control commands
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Example: //Initiate remote session
&GTR
//Send commands
MEAS:START
MEAS:SAVE 'A great measurement'
//Close the remote session
&GTL

Usage: Event

&GTR

Initiates a remote session.

Always send this command before sending a sequence of commands.

During a remote session, the user interface is unavailable. To access the user interface
again, you have to return to local mode via the user interface or end the remote ses-
sion with &GTL.

Example: //Initiate remote session
&GTR
//Send commands
MEAS:START
MEAS:SAVE 'A great measurement'

Usage: Event

MEASurement:EVALuation:MASK:ENABle <State>

Turns phase evaluation masks on and off.

Setting parameters: 
<State> 0

Phase mask = off
1
Phase mask = on
*RST: 0

Example: //Deactivate a phase mask
MEAS:EVAL:MASK:ENAB 0

MEASurement:EVALuation:MASK:LOAD <FileName>

Loads an evaluation mask for phase measurements and also activates the phase
mask.

Setting parameters: 
<FileName> String containing the path (.bmp file) to the bitmap you want to

load.

Remote control commands
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Example: //Load a bitmap file
MEAS:EVAL:MASK:LOAD 'c:\hi.bmp'

Usage: Setting only

MEASurement:EVALuation:WINDow <XSize>, <YSize>

Defines the size of the evaluation window.

Setting parameters: 
<XSize> Length of the horizontal side of the evaluation window in mm.

Range: 10  to  100

<YSize> Length of the vertical side of the evaluation window in mm.
Range: 10  to  100

Example: See Chapter 12.3, "Remote control examples", on page 68.

Usage: Setting only

MEASurement:GRID:CONFig <CellSizeX>, <CellSizeY>, <GridPositionX>,
<GridPositionY>, <CellsX>, <CellsY>

Defines the size and location of an evaluation grid.

Setting parameters: 
<CellSizeX> Size of a grid cell in x-direction.

*RST: 0
Default unit: mm

<CellSizeY> Size of a grid cell in y-direction.
*RST: 0
Default unit: mm

<GridPositionX> Location of the grid on the x-axis relative to origin of the evalua-
tion window.
*RST: 0
Default unit: mm

<GridPositionY> Location of the grid on the y-axis relative to origin of the evalua-
tion window.
*RST: 0
Default unit: mm

<CellsX> Number of cells on the x-axis.
*RST: 0

<CellsY> Number of cells on the y-axis.
*RST: 0

Example: See MEASurement:GRID:RESult? on page 63

Usage: Setting only

Remote control commands
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MEASurement:GRID:ENABle <State>

Turns the measurement using an evaluation grid on and off.

Setting parameters: 
<State> ON | OFF | 1 | 0

*RST: OFF

Example: See MEASurement:GRID:RESult? on page 63

MEASurement:GRID:RESult?

Queries the results of the grid measurement.

1 2 3 4 5

6 7 8 9 ...

Return values: 
<Results> String that contains the location of the grid cells and the mea-

surement results for each grid cell.
For each cell, the command returns the average transmission
and phase results for both frequency bands. The number of
results depends on the number of cells in the grid.

Example: //Define a grid with 25 cells (five on the x-axis and five on the y-
axis)
MEAS:GRID:CONF 5,5,0,0,5,5
MEAS:GRID:ENAB ON
MEAS:GRID:RES?
would return the results in a .txt file
#<number_of_characters in the file>
"GridCoordinatesX": location of the cell borders in x-direction in mm
"GridCoordinatesY": location of the cell borders in y-direction in mm
"GridCoordinatesXMean": location of the center of each cell in x-direction in mm
"GridCoordinatesYMean": location of the center of each cell in y-direction in mm
"Transmission":
    "Attenuation":
      "PhasemaskBand1": results for each cell from top left to bottom right devided by grid rows
      "PhasemaskBand2":
      "HighResBand1":
      "HighResBand2":

Usage: Query only

Remote control commands
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MEASurement:HQMode:ENABle <State>

Turns high quality mode on and off.

Setting parameters: 
<State> 0

High quality mode = off
1
High quality mode = on
*RST: 0

Example: //Turn on high quality mode
MEAS:HQM:ENAB 1

MEASurement:LOAD <Directory>

Restores previously recorded measurement data.

The restored data depends on what was saved (MEASurement:RESult:SAVE:WHAT
).

Setting parameters: 
<Directory> String containing the path to the directory that contains the data-

set.

Example: //Restore measurement data
MEAS:LOAD 'c:
\qar50\measurements\20211111-111111_measurement0001'

Usage: Setting only

MEASurement:NORMalize:REFLection:REQuired?

Queries if the reflection measurement has been normalized.

Return values: 
<State> 1 | 0

If the result is 1, normalize the measurement with
MEASurement:NORMalize:REFLection:STARt.
If the result is 0, the measurement is already normlized. You can
proceed with the actual measurement.

Example: See Chapter 12.3, "Remote control examples", on page 68.

Usage: Query only

MEASurement:NORMalize:REFLection:STARt

Initiates a normalization of the reflection measurement.

Example: See Chapter 12.3, "Remote control examples", on page 68.

Usage: Event

Remote control commands
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MEASurement:NORMalize:TRANsmission:REQuired?

Queries if the transmission measurement has been normalized.

Return values: 
<State> 1 | 0

If the result is 1, normalize the measurement with
MEASurement:NORMalize:TRANsmission:STARt.
If the result is 0, the measurement is already normlized. You can
proceed with the actual measurement.

Example: See Chapter 12.3, "Remote control examples", on page 68.

Usage: Query only

MEASurement:NORMalize:TRANsmission:STARt

Initiates a normalization of the transmission measurement.

Example: See Chapter 12.3, "Remote control examples", on page 68.

Usage: Event

MEASurement:RESult?

Queries the numerical measurement results.

Return values: 
<Result> Byte array containing the result value in .json format.

The array has the following structure:
#<headervalue1><headervalue2><data>
• #: hash sign
• <headervalue1>: length of the length information (number of
digits)
• <headervalue2>: length information of the binary data (num-
ber of bytes)
• <data>: binary data with the indicated number of bytes
Example for the header: #3376, binary data has a length of 376
bytes. The number of digits of the length information is 3.
For an example of the structure of the .json file, see "Structure
of the .json file containing results" on page 70.

Example: See Chapter 12.3, "Remote control examples", on page 68.

Usage: Query only

MEASurement:RESult:DIRectory <Directory>

Defines the base directory in which measurement are stored.

The results themselves are stored in a subfolder of this directory. The subfolder has a
fix naming logic.

Remote control commands
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Parameters:
<Directory> String containing the path to the directory.

Example: See Chapter 12.3, "Remote control examples", on page 68.

MEASurement:RESult:SAVE:AUTO <State>

Turns automatic saving of the results of each measurement on and off.

Parameters:
<State> 1 | 0

*RST: 1

Example: See Chapter 12.3, "Remote control examples", on page 68.

MEASurement:RESult:SAVE:WHAT <Data>

Selects the data that is stored in a dataset.

Parameters:
<Data> 0

Saves numerical results.
1
Saves all results and images.
2
Saves all results, images and 3D data.
*RST: 1

Example: See Chapter 12.3, "Remote control examples", on page 68.

MEASurement:SAVE? [<Description>]

Saves the results of the last measurement and returns the location of the results.

We recommend turning off automatic result saving if you use this command
(MEASurement:RESult:SAVE:AUTO). If you use this command in addition to the
automatic saving of results, the R&S QAR50 saves the results a second time.

Query parameters: 
<Description> Optional parameter.

String that contains the description (or name) of a specific mea-
surement.

Return values: 
<Directory> String that contains the path to the directory in which the results

are stored.

Example: See Chapter 12.3, "Remote control examples", on page 68.

Usage: Query only

Remote control commands
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MEASurement:STARt

Initiates a measurement (reflection, transmission and phase measurement).

Example: See Chapter 12.3, "Remote control examples", on page 68.

Usage: Event

SYSTem:ERRor

Queries the most recent error queue entry for SCPI errors and deletes it. SCPI errors
have a negative number.

To query device errors, use SYSTem:STATus:ERRor[:NEXT]?.

Possible SCPI errors are defined in the SCPI standard.

For a list of possible errors, see Chapter 14, "Troubleshooting error messages",
on page 76.

Return values: 
<ErrorCode>

<ErrorMessage>

Usage: Event

SYSTem:STATus:ERRor[:NEXT]?

Queries the most recent error queue entry for device errors and deletes it. Device
errors have a positive sign.

To query SCPI errors, use SYSTem:ERRor.

For a list of possible device errors, see Chapter 14, "Troubleshooting error messages",
on page 76.

Return values: 
<ErrorCode>

<ErrorMessage>

Usage: Query only

SYSTem:EXIT

Shuts down the system.

Shutting down the system automatically closes the SCPI connection.

Example: //Shut down the system
SYST:EXIT

Usage: Event

Remote control commands
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SYSTem:REBoot

Reboots the system.

Rebooting the system automatically closes the SCPI session. If you want to continue
remote controlling the system after the reboot, you have to re-establish the SCPI ses-
sion after the reboot with &GTR.

Example: //Reboot system
SYST:REB

Usage: Event

SYSTem:STATus:CODE?

Queires the current system status.

Return values: 
<StatusCode> 0

System ready for operation.
1
System is initializing.
2
System has an initialization error.
You can query the details about the error with SYSTem:
STATus:ERRor[:NEXT]?.

Example: See Chapter 12.3, "Remote control examples", on page 68.

Usage: Query only

12.3  Remote control examples

The following examples show a typical sequence of remote commands to perform a
measurement with the R&S QAR50.

Programming example for a measurement

//Initiate SCPI session
&GTR
//Query system status
SYST:STAT:CODE?
//If result = 0, system is ready for operation
//Define size of evaluation window
MEAS:EVAL:WIND 50,50
//Define settings for automatic result storage
MEAS:RES:SAVE:AUTO 1
MEAS:RES:SAVE:WHAT 1
MEAS:RES:DIR 'c:\qar50\mymeasurements\'
//Run measurement

Remote control examples
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MEAS:NORM:REFL:REQ?
//If result = 1, normalize reflection measurement
MEAS:NORM:REFL:STAR
MEAS:NORM:TRAN:REQ?
//If result = 1, normalize transmission measurement
MEAS:NORM:TRAN:STAR
MEAS:STAR
MEAS:RES?
//returns, e.g.:
#41372{
 "reflection" : {
  "S11" : {
         "mean_Band1dB" : -35.18,
         "mean_Band1Percent" : 1.74,
         "mean_Band2dB" : -36.36,
         "mean_Band2Percent" : 1.54,
         "FResponseMinimumdB" : -58.00,
         "FResponseMinimumPercent" : 0.12,
         "FResponseMinimumFrequencyValue" : 81039370078.47,
     }
 }
}
//etc.

//Query location of the measurement results
MEAS:SAVE? 'test'
//Restore the results
MEAS:LOAD 'c:\qar50\mymeasurements\20211111-111111_test'
//End SCPI session
&GTL

Programming example to verify phase measurements

Requires a verification plate "D" with serial number ≥ 101350.

//Initiate SCPI session
&GTR
//Load first evaluation mask
MEAS:EVAL:MASK:LOAD 'C:\Program Files (x86)\Rohde-Schwarz\QAR50\config\
evaluationMask_70_30_0_20.bmp'
// Start first measurement
MEAS:STAR
//Query and store measurement results of the first measurement
MEAS:RES?
//Load second evaluation mask
MEAS:EVAL:MASK:LOAD 'C:\Program Files (x86)\Rohde-Schwarz\QAR50\config\
evaluationMask_70_30_0_-20.bmp'
//Start second measurement
MEAS:STAR
//Query and store measurement results of the second measurement
MEAS:RES?

Remote control examples
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After the two measurements, substract the mean phase results of the first measure-
ment from the second measurement and compare the absolute value of the results
with the values printed on the plates.

Structure of the .json file containing results

{
    "Reflection" : {
        "S11" : {
            "MeanBand1dB" : -11.44,
            "MeanBand1Percent" : 26.78,
            "MeanBand2dB" : -15.30,
            "MeanBand2Percent" : 17.17,
            "FResponseMinimumdB" : -23.68,
            "FResponseMinimumPercent" : 6.55,
            "FResponseMinimumFrequencyValue" : 80881889763.51
            },
        "S22" : {
            "MeanBand1dB" : -12.64,
            "MeanBand1Percent" : 23.34,
            "MeanBand2dB" : -16.74,
            "MeanBand2Percent" : 14.55,
            "FResponseMinimumdB" : -40.24,
            "FResponseMinimumPercent" : 0.97,
            "FResponseMinimumFrequencyValue" : 80803149606.02
            }
        },
    "Transmission" : {
        "Attenuation" : {
            "MeanBand1dB" : 0.55,
            "MeanBand1Percent" : 6.18,
            "MeanBand2dB" : 0.44,
            "MeanBand2Percent" : 4.89,
            "MeanPhaseBand1Degree" : 159.50,
            "MeanPhaseBand1Milliradian" : 2783.77,
            "MeanPhaseBand2Degree" : 152.85,
            "MeanPhaseBand2Milliradian" : 2667.78,
            "StdDevPhaseBand1Degree" : 0.70,
            "StdDevPhaseBand1Milliradian" : 12.16,
            "StdDevPhaseBand2Degree" : 0.67,
            "StdDevPhaseBand2Milliradian" : 11.76,
            "MaxDevPhaseBand1Degree" : 2.11,
            "MaxDevPhaseBand1Milliradian" : 36.83,
            "MaxDevPhaseBand2Degree" : 1.86,
            "MaxDevPhaseBand2Milliradian" : 32.46,
            "FResponseMinimumdB" : 0.29,
            "FResponseMinimumPercent" : 3.34,
            "FResponseMinimumFrequencyValue" : 80566929133.58
            }

Remote control examples
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        }
    }

Remote control examples
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13  Real-time imaging
Real-time imaging is an optional application that allows you to display live images of a
test object. You can use these images to check the test object for faults in your own
post processing tools. The application runs continuous measurements that result in a
continuous image stream of the characteristics of the test object, like a video stream.
The image stream is based on the WebSocket protocol. The frame rate depends on
the configuration of the test setup - with a standard configuration frame rate is about 30
fps.

With the R&S QAR50-K80, you can measure the reflection and phase characteristics
of the test object.

The real-time imaging application uses a different software environment than the base
unit. This software is REST API based on the OpenAPI standard, but you can also use
a basic user interface that comes with the application.

Using the radome measurement software of the base unit and the software of the real-
time imaging application at the same time is not possible.

Accessing the real-time imaging application

The easiest way to access the real-time imaging application directly is a local connec-
tion with a web browser. You can use this method to get familiar with the application
and view the API documentation.

1. Start the real-time imaging software using the shortcut on the desktop.

2. Open a web browser on the R&S QAR50.

3. Enter the IP address of the local host (127.0.0.1:8000).
The web browser displays the functions provided by the real-time imaging applica-
tion, including the documentation of the API. You can get all API functions and the
type it is from this documentation.

This page also has a few quick links to access the most important functions.
● "Get live image": Shows a non moving image of the current measurement

(frame).
● "Get live video": Shows a video stream of the measurement, including the num-

ber of measurements (frames) that have been streamed in this session.

When you open the video stream in the browser, you can access a few selected func-
tions in the browser.
● Result type selection
● Distance from object to cluster
● Dynamic range
● Color map
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Working with the real-time imaging application

Frequency
Defines the frequency range of the measurement.
We recommend using the frequency ranges the R&S QAR50 is calibrated for.
● 72 GHz to 82 GHz (256 frequency points)
● 76 GHz to 81 GHz (128 frequency points)
Using other frequency range requires a recalibration of the setup. If you need to use
different frequency ranges, contact your Rohde & Schwarz representative.
Remote command: 
/initialize?f_start=<start_freq.>&f_stop=<stop_freq.>
&num_frequencies=<freq._point>

Live image
Queries an image of the current measurement.
The live image is available in different formats: .png, .jpg, .bmp
The API returns the raw image data in binary format that you can use for further evalu-
ations.
Remote command: 
/live-image.png
/live-image.jpg
/live-image.bmp

Live video
Starts the user interface that shows the live stream of the recorded image.
To access the live stream from the client, open a WebSocket with the command /ws.

The API starts sending continuous messages to the connected client. The client must
differentiate between one of two different message types:
● json: The json string contains the metadata of the live stream (frame rate, frame

count etc.). You can get the detailed contents from the REST API documentation.
● bytes: The byte stream contains the raw image data in binary .jpg format that you

can use for further image evaluation.
When you disconnect the client from the WebSocket, the live stream stops.

Remote command: 
/live-video

Result type
Selects the displayed result type of the measurement.
Magnitude Shows the amplitude characteristics of the reflection measurement of

the test object.
Phase Shows the phase characteristics of the reflection measurement of the

test object.
Remote command: 
Turn on phase results: /phase-visualization?show_phase=true
Turn off phase results: /phase-visualization?show_phase=false
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Origin of the image
Defines the position of the evaluation window and distance of the test object to the
cluster. Note that all values are in "m" (meters).
Note: By default, the size of the evaluation window is 256 mm x 256 mm. It is not pos-
sible change the size of the evaluation while the measurement is running. If you need a
custom window size, contact your R&S QAR50 representative.
The positioning parameters also contain a function pipe_id (pipeline ID) which has
an effect on image reconstruction. By default, the real-time imaging application uses
one pipeline. We recommend not changing this value.
x-position Defines the position of the evaluation window in horizontal direction.

The point of origin is the lower left edge of the image. Therefore,
entering a positive value moves the reconstruction volume to the
right.

y-position Defines the position of the evaluation window in vertical direction.
The point of origin is the lower left edge of the image. Therefore,
entering a positive value moves the reconstruction volume down-
wards.

z-position Defines the distance between test object and cluster.
Remote command: 
/origin?xpos=<hor.pos.>&ypos=<vert.pos.>&zpos=<distance>

Color map for the image
Selects the color map for the image. The color map defines the type of colors used in
the image.
Note that the phase results do not support all color maps.
Remote command: 
colormap/viridis
colormap/ocean
colormap/turbo
colormap/black & white

Dynamic range
Defines the range of amplitude levels that the image displays.
The dynamic range allows you to improve the contrast of the image by removing cer-
tain level ranges from the image. The effect is that you can highlight certain details in
the image and thus get a more balanced image.
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Example: 
The displayed level range is 100 dB.

However, levels of interest occur only in a small level range. Most parts of the color
range represent noise or ripples that you do not want to see.
When you reduce the dynamic range, the contrast between interesting and non-inter-
esting parts of the image increases - non-interesting parts become black areas in the
image.

You can define a different dynamic range for magnitude and phase measurements.
Remote command: 
Dynamic range magnitude:
/dynamic-range/magnitude?rel_offset_min=<level>&rel_offset_max=<level>
Dynamic range phase:
/dynamic-range/phase?val_min=<level>&val_max=<level>

Normalization
Turns automatic normalization of the measured amplitudes on and off.
Available for magnitude measurements only.
True The R&S QAR50 automatically normalizes the measured amplitudes

to the maximum amplitude within the reconstructed image to get the
best result for each image.

False The R&S QAR50 does not normalize the measured amplitude after
each measurement. Not normalizing the measurement can lead to
images in which the magnitude is clipped.

Remote command: 
Normalization on: /magnitude-normalization?normalize-magnitude=true
Normalization off: /magnitude-normalization?normalize-magnitude=false

Get settings
Queries the current measurement settings.
Remote command: 
/settings
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14  Troubleshooting error messages
If there are any errors, you can view the details by selecting "Errors" in the user inter-
face. If you cannot solve the error, contact your Rohde & Schwarz service representa-
tive and send them the error log. You can export the error log with "File" > "Dump all
log files". In addition to the error log, the log file also contains other useful information
that allows service to solve the issues.

The following errors (hardware and software) can occur during the operation of the
R&S QAR50. Try to resolve the error with the suggested solutions.

Table 14-1: Possible errors for the R&S QAR50

Error code Description Solution

Err_1 Error: Error while getting the firmware. Try restarting the device.

Err_2 Error: Updating all FPGA files failed. Read next entry in errorqueue.

Err_3 Error: Failed to initialize the firmware. Try restarting the device.

Err_4 Error: Failed to initialize the device. Read next entry in errorqueue.

Err_5 Error: Warming up the hardware failed. Read next entry in errorqueue.

Err_6 Error: Interrupting the hardware warmup failed. Read next entry in errorqueue.

Err_7 Error: Could not switch to reconstruction using GPU. Try restarting the device.

Err_8 Error: Could not switch to reconstruction using CPU. Try restarting the device.

Err_9 Error: Could not load user config Reinstall the software.

Err_10 Error: Could not load device config Reinstall the software.

Err_11 Error: Could not save user config Make sure there is sufficient storage space.

Err_12 Error: Could not save device config Make sure there is sufficient storage space.

Err_13 Error: Could not get the Matlab status. Try restarting the device.

Err_14 Error: Could not get the device status. Try restarting the device.

Err_15 Error: Could not get the temperature result. Try restarting the device.

Err_16 Error: Could not create the folder Make sure there is sufficient storage space.

Err_17 Error: Could not set the save level Use a supported savelevel.

Err_18 Error: Could not load result. The results.mat file does
not exist

Save your results in a higher savelevel.

Err_19 Error: Could not load result data Incompatible result.

Err_20 Error: Could not load result Make sure the path contains a valid result.

Err_21 Error: Could not save result Make sure there is sufficient storage space.

Err_22 Error: Error during the normalization. Repeat the normalization measurement.

Err_23 Error: Normalization is required before performing a
measurement.

Perform a normalization measurement.

Err_24 Error: The device is not ready for a measurement now. Read next entry in errorqueue.
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Error code Description Solution

Err_25 Error: Measurement failed. Read next entry in errorqueue.

Err_26 Error: The device is busy at the moment. Please try sending the command again.

Err_27 Error: Evaluation window parameters are out of range. Use compatible evaluation window settings.

Err_28 Error: Dumping the log files failed. Try restarting the device.

Err_29 Error: Calibration failed. Rename the last backup Calibraion folder to 'Calibra-
tionData' and try restarting the device.

Err_30 Error: Loading evaluation phase mask file failed. Check the log files for detail.

Err_31 Error: Resolution verification failed. Check the log files for detail.

Err_100 Error: Error file is missing, or corrupt. Reinstall the software.

Err_101 Error: Driver instance not available. Read next entry in errorqueue.

Err_102 Error: Could not open reconstruction interface instance. Read next entry in errorqueue.

Err_103 Error: Could not open Matlab interface. Read next entry in errorqueue.

Err_104 Error: Initialization failed. Read next entry in errorqueue.

Err_105 Error: Device initialization missing. Read next entry in errorqueue.

Err_106 Error: Hardware Driver was not released. Check .\logs
\HW_driver*.txt for more details.

See HW_driver.txt for more details.

Err_107 Error: Settings invalid, please adjust settings. Reset settings to default values.

Err_108 Error: Switching to CPU reconstruction failed. Try restarting the device.

Err_109 Error: Switching to GPU reconstruction failed. Try restarting the device.

Err_110 Error: Calibration data missing. Calibrate the device or restore calibration data.

Err_111 Error: Cannot get data from Hardware Driver.
Check .\logs\HW_driver*.txt for more details.

See HW_driver.txt for more details.

Err_112 Error: GPU reconstruction and transfer to Matlab failed. Read next entry in errorqueue.

Err_113 Error: GPU based result calculation in Matlab failed. Read next entry in errorqueue.

Err_114 Error: CPU based result calculation in Matlab failed. Read next entry in errorqueue.

Err_115 Error: CPU reconstruction not available w/o Matlab. Read next entry in errorqueue.

Err_116 Error: Transferring data to Matlab. Read next entry in errorqueue.

Err_117 Error: Matlab initialization failed. Reinstall the software.

Err_118 Error: Matlab getting or reading results failed. Try restarting the device.

Err_119 Error: Matlab save result failed. Read next entry in errorqueue.

Err_120 Error: Unable to read json file. Reinstall the software.

Err_121 Error: No config.json file found. Reinstall the software.

Err_122 Error: Failed to calibrate the system. Read Matlab logfile for more details.

Err_123 Error: FPGA files missing. Reinstall the software.
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Error code Description Solution

Err_124 Error: Wrong format queried. Please query result cor-
rectly.

Reinstall the software.

Err_125 Error: GPU reconstruction volume missing. Please run
GPU reconstruction first.

Reinstall the software.

Err_126 Error: Evaluation mask size invalid. Reset settings to default values.

Err_127 Error: Failed to open file. Check data integrity of file.

Err_128 Error: Invalid setting in config.json. Reset settings to default values.

Err_129 Error: Reconstruction json file must contain a recon-
struction indicator and a cluster combination.

Reinstall the software.

Err_130 Error: Cannot access file .\config\FanControllerParame-
ters.json.

Reinstall the software.

Err_131 Error: Object in FanControllerParameters.json holds
inadequate number of elements.

Reinstall the software.

Err_132 Error: Fast Warmup procedure did not reach the goal
temperature given in config.json.

Adjust temperature fields synthesizerTemp (environment
+ 10 K) and clusterTemp (environment + 5 K) in con-
fig.json.

Err_133 Error: Fast Warmup procedure did not reach the goal
temperature given in normalization files.

Normalize transmission and reflection and restart soft-
ware.

Err_150 Error: Hardware initialization failed. Check .\logs
\HW_driver*.txt for more details.

See HW_driver.txt for more details.

Err_151 Error: FPGA version needs to be updated. Reinstall the software and restart the device.

Err_152 Error: Mainboard fan FAN1: Synthesizer defective. Replace defective fan.

Err_153 Error: Mainboard fan FAN2: Power Supply defective. Replace defective fan.

Err_154 Error: Mainboard fan FAN3: FPGA defective. Replace defective fan.

Err_155   

Err_156 Error: Mainboard fan FAN5: CEX defective. Replace defective fan.

Err_157 Error: Cluster 1 fan defective. Replace defective fan.

Err_158 Error: Cluster 2 fan defective. Replace defective fan.

Err_159 Error: Raw Data Test failed. Please check output folder
for more details.

Check Matlab logfile for more details.

Err_160 Error: Getting part temperatures failed. Read next entry in errorqueue.

Err_161 Error: Failed to read fan speeds. Check .\logs
\HW_driver*.txt for more details.

See HW_driver.txt for more details.

Err_162 Error: Failed to set fan speeds. Check .\logs
\HW_driver*.txt for more details.

See HW_driver.txt for more details.

Err_163 Error: Temperature control settings exceed maximum
ratings.

Reset settings to default values.

Err_164 Error: Failed to read mainboard FPGA temperature. Restart device, or replace defective component.

Err_165 Error: Failed to read digital cluster FPGA temperature. Restart device, or replace defective component.
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Error code Description Solution

Err_166 Error: Failed to read synthesizer temperature. Restart device, or replace defective component.

Err_167 Error: Failed to read Tx Tera chip temperature. Restart device, or replace defective component.

Err_168 Error: Failed to read Rx Tera chip temperature. Restart device, or replace defective component.

Err_180 Error: No appropriate GPU found. Check "Display adapters" availability in "Device Man-
ager". Replace graphics card, if necessary.

Err_181 Error: Installed GPU has too less memory. Check "Display adapters" in "Device Manager". Replace
graphics card, if the installed has < 8 GB memory.

Err_200 Error: Error list file is missing. Reinstall the software.

Err_201 Error: CAL_CONF file does not exist. Reinstall the software.

Err_202 Error: Save path folder can not be created. Change save path to a valid path and make sure there
is sufficient storage space.

Err_203 Error: Result directory can not be created. Change save path to a valid path and make sure there
is sufficient storage space.

Err_204 Error: Normalization folder is missing. Normalize the device.

Err_205 Error: Reflection normalization file is missing. Normalize the device.

Err_206 Error: Loading reflection normalization data failed. Using
default normalization data.

Normalize the device.

Err_207 Error: Transmission normalization file is missing. Normalize the device.

Err_208 Error: Loading transmission normalization data failed.
Using default normalization data.

Normalize the device.

Err_209 Error: Result directory does not exist. Use a valid result directory when loading results.

Err_210 Error: Result volume file does not exist. Try loading the result without the volume file.

Err_211 Error: Loading savefile failed. File might be corrupted. Try to repair the corrupted file.

Err_212 Error: File could not be saved. Change save path to a valid path and make sure there
is sufficient storage space.

Err_213 Error: Configuration file config.json is missing. Reinstall the software.

Err_214 Error: Configuration file config.json is corrupted. Reinstall the software.

Err_215 Error: Tolerance file is corrupted. Try to repair the corrupted file.

Err_216 Error: Tolerance file is missing. Specify a valid tolerance file.

Err_217 Error: Could not save normalization data. Make sure there is sufficient storage space.

Err_218 Error: Loading calibration data failed. Calibrate the device or restore calibration data.

Err_219 Error: Calibration data missing. Calibrate the device or restore calibration data.

Err_220 Error: Failed to save calibration data. Make sure there is sufficient storage space.

Err_221 Error: Evaluation mask file is corrupted. Try to repair the corrupted file.

Err_222 Error: Evaluation mask file is missing. Specify a valid evaluation mask.

Err_223 Error: Evaluation mask file is incompatible. Specify a valid evaluation mask.
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Error code Description Solution

Err_224 Error: Loading of calGeometryError.mat failed. Reinstall the software.

Err_225 Error: Reflection normalization failed. Not a valid refer-
ence plate position.

Make sure the metal plate for the normalization is paral-
lel to the antenna cluster surfaces, or disable the posi-
tion check.

Err_226 Error: Transmission normalization failed. Main transmis-
sion is not centered.

Make sure the space between the clusters is empty, or
disable the position check.

Err_227 Error: RawDataTest of synthesizer ref. channel failed. Call your service representative.

Err_228 Error: RawDataTest of LO/RF swap failed. Make sure that the LO and RF cabels are correct con-
nected.

Err_229 Error: RawDataTest of badChannels failed. Call your service representative.

Err_230 Error: RawDataTest of SNR and signal power failed. Call your service representative.

Err_231 Error: RawDataTest of cluster swap failed. Make sure that cluster modules are connected to the
correct cascade.
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15  Maintenance, storage and disposal
The product does not require regular maintenance. It only requires occasional clean-
ing. It is however advisable to check the nominal data from time to time.

15.1  Cleaning

The R&S QAR50 and its accessories are sensitive devices. Clean the R&S QAR50 in
an appropriate manner to prevent the components from getting damaged.

Cleaning the R&S QAR50

1. Clean the measurement electronics (cluster and calibration sphere) only if neces-
sary (visible dirt particles). If cleaning these parts becomes necessary, do so care-
fully with a dry, lint-free duster.
Do not use liquids to clean the measurement electronics. Using liquids can lead to
inaccurate measurements.

2. Clean the frame and rear side of the R&S QAR50 with a lint‑free duster. For stub-
born dirt, you can also wipe the frame and rear side with a damp rag.

3. We recommend not to clean the absorbers, because they can break easily. If the
absorbers become too dirty, contact Rohde & Schwarz service to replace them with
new ones.

Cleaning the verification kit

► Clean the verification kit with a soft, lint-free dust cloth. If necessary, you can
dampen the cloth.
Do not use chemical cleaning agents or solvents like alcohol or cellulose lacquer
thinners.

15.2  Storage

Protect the product against dust. Ensure that the environmental conditions, e.g. tem-
perature range and climatic load, meet the values specified in the data sheet.

15.3  Disposal

Rohde & Schwarz is committed to making careful, ecologically sound use of natural
resources and minimizing the environmental footprint of our products. Help us by dis-
posing of waste in a way that causes minimum environmental impact.

Disposal
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Disposing of electrical and electronic equipment

A product that is labeled as follows cannot be disposed of in normal household waste
after it has come to the end of its life. Even disposal via the municipal collection points
for waste electrical and electronic equipment is not permitted.

Figure 15-1: Labeling in line with EU directive WEEE

Rohde & Schwarz has developed a disposal concept for the eco-friendly disposal or
recycling of waste material. As a manufacturer, Rohde & Schwarz completely fulfills its
obligation to take back and dispose of electrical and electronic waste. Contact your
local service representative to dispose of the product.

Disposal
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16  Contacting customer support
Technical support – where and when you need it

For quick, expert help with any Rohde & Schwarz product, contact our customer sup-
port center. A team of highly qualified engineers provides support and works with you
to find a solution to your query on any aspect of the operation, programming or applica-
tions of Rohde & Schwarz products.

Contact information

Contact our customer support center at www.rohde-schwarz.com/support, or follow this
QR code:

Figure 16-1: QR code to the Rohde & Schwarz support page

https://www.rohde-schwarz.com/support
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17  Transporting
Lifting and carrying

See:
● "Lifting, carrying and installing the product" on page 6

Packing

Use the original packaging material. It consists of antistatic wrap for electrostatic pro-
tection and packing material designed for the product.

If you do not have the original packaging, use similar materials that provide the same
level of protection. You can also contact your local Rohde & Schwarz service center for
advice.

Securing

When moving the product in a vehicle or using transporting equipment, make sure that
the product is properly secured. Only use items intended for securing objects.

Transport altitude

The maximum transport altitude without pressure compensation is 4500 m above sea
level.
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